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1  Introduction 

 
Welcome to the Log File Reader software manual. This document describes how to use this software 
application. 
The purpose of the software is read back Perception logged data into a Perception User Table. A 
special user interface is created to make this possible.  
The application is based on the Perception Custom Software Interface (CSI). 
This manual assumes you understand your Genesis HighSpeed Test and Measurement equipment, 
software and basic acquisition terminology. You may like to use the Perception User Manual as a 
reference. 
 

2 Scope 

This Perception software extension enables the use of Log File Reader. 
Via the new software the operator can do the following things: 
 

• Read back Perception logged data into a Perception User Table. 

• Format the layout of the read data.  

• Filter the data to be read from the logging file 

• Sort the data to be read from the logging file 

• Multiple user tables can be created each with the same or different layout and different data  

• The user table(s) can be used to export the data to a table in Microsoft Word 

• The user table(s) can be used to export the data to Microsoft Excel 

• The user table(s) can be used by the Perception report sheet.  
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3 Getting Started 

 

3.1 Installation 

 
The Log File Reader software will be delivered electronically as an install file. This manual will be part 
of the install. 

 
 
Depending on the Perception version either a 32 or 64 bit install will be done. 
 

• Run the install file of the  Log File Reader  
 

 
 
 

 

• Click Next, and follow the on-screen instructions to complete the installation. When the 
process is complete, a message tells you that the option is installed. Click Finish. 

  
 
Now the software and manual should be installed on your PC. 
The Log File Reader software is not a stand-alone program which can be started from the Windows 
Start menu! It is an integrated part of the Perception software program. Once you start Perception you 
can create multiple instances by right mouse click on the tab area of the sheets. This works similar as 
adding a new user sheet. The picture below shows the menu from where you can select the New Log 
File Reader item. 
 

 
  
 
The manual has also been installed on your PC. It is a PDF file which can be opened via the windows 
HBM menu. 
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If you cannot open this pdf file then you may have to install the Acrobat® Reader®. 
 

3.2 Requirements 

 
Log File Reader software operates on any PC where Perception is running. 
 
The Log File Reader application can only be used when the HASP® USB key CSI option has been 
enabled. You can check if this option has been enabled by going to the Help About dialog and click 
More…. 
The “More About Perception” dialog shows which options are enabled. 
 

The CSI option icon looks like:  
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4 Log File Reader 

4.1 General 

A new Log File Reader sheet can be created via the Sheets menu. 
 

 
 
Or you can use a right mouse click at the tab area of the sheets. 
 
The Log File Reader contains a Menu Panel, and a fixed user table. Initially the user table and the 
entry field for the name of the log file are empty. 
 

 
 
It is possible to create multiple Log File reader sheets, each with its own layout and log data. 
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4.1 Reading Perception log file 

 
The first thing to do is select a Perception created log file. In the Perception user manual you can find 
how to create such a Perception log file, search for the key word ‘Logfile’. When using the logging 
feature of Perception it is possible to add a line per recording to a log file. This can be done 
automatically after a recording has been done. The log file can contain any string or numerical data 
sources available in the Perception. The log file is an xml structured file. 
Below an example of a raw log file called Logfile.XML. 
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In this log file you can find for example I1_Maxval, this is the maximum value of the signal I1 as 
calculated by a formula in the formula database. Enter the correct log file name and the log file will 
automatically be read. You always can force a re-read by clicking at the (re)Read log file button. 
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You now can see that each recording is one line in the user table. The next chapter shows you how 
you can modify the layout. 
 

4.2 Table Layout 

 
The layout of the user table can be modified via the Table Layout menu.  
 
Click at the menu button Table layout and the Table Layout dialog appears: 
 

 
 
This dialog is used to create a nice layout for showing the logging data into the user table. 
 
At the left hand side of the dialog the available log-file data fields are shown. At the right hand side you 
see a data grid showing a green header row and a second row showing the various data fields. This is 
the layout you get the first time, or when you press the Default setup button.  
At the top you can see the number of columns of the layout grid and also the number of rows. This 
number defines the number of rows that will be used in the user table per recording. By default it is set 
to 1, but most likely you will use multiple rows. 
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We will now change the configuration in a way that the data is shown in a nicer layout. 
In the example below we reduce the number of columns to 9 and the number of rows to 4. 
We can modify the header by directly typing the column titles in here. 
The available log-file data fields can be drag-dropped in the grid cells or by using the Insert . 
 

  
You can change the configuration by using the following context menu of a grid cell (Right mouse click 
on a cell):  
 

 
 
Insert Log Field  
 
If you select this the following dialog will be shown: 
 

 
 
 
Via this dialog you can select a log-file data field and also how the data should be shown, this 
formatting part is almost simular to that of a standard Perception user table. 
 
The other menu items do have simular functionality as there is for a user table and are very self 
explaining. 
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Once you have finished your table layout you can close this window by clicking at the OK button. The 
logging data will be re-read again and will be shown conform the table layout you just have created. In 
our example this looks like: 
 

 
 
If you reopen the Table Layout window again you see a couple of buttons at the bottom. 
 
Default setup 
This button is used to create a default setup, this setup has only one row per recording and the number 
of columns is set equal to the number of available log-file data fields. Most of the time this layout is not 
very useful, but can be a good start for a new table layout. 
 
Save 
The save button is used to save your current table layout into a separate file, a so called Log Layout 
File with default extension of .pLLF. This file can be reused later by this or another Log File Reader 
sheet.  
 
Load 
The load button is used to load an existing layout, see the Save option above. 
 

4.3 Recording selection 

 
Each time Perception has finished a recording a line of data will be added to the log file, consequently 
it is possible that the log file will become very large, maybe too large for a user table. Therefore you 
can use the Recording Selection dialog, here you can select which recordings you want to used for 
the current Log File reader table.  
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You can also modify the order of the recordings, this can be done via the arrow keys at the right hand 
side. You can select one or more recordings and use the arrow keys to shift the selected recordings up 
or down. 
 
It is also possible to change the order of the recordings by clicking at the titles at the header of a 
column. The recordings are sorted conform the values of the selected column, this sorting order can be 
reversed by clicking a second time at the same title. In the example below we have clicked twice at the 
Cycles title column, now the recordings are ordered in a way that the recording having the largest 
number of cycles is shown first. 
 

 
 
If you have many recordings in a log file then we advice you to open this Recording selection dialog 
as one of the first things to be done; select a limited number of recordings and continue with for 
example the Table Layout. Working this way will speed up the reading of the log file and showing the 
formatted data. Especially when you are using different fonts or font-styles the limiting of the number of 
recordings helps to speed up things. 
When you now close the Recording Selection dialog the table will be cleared and recreated. As you 
can see the ordering has been changed, the recording with the largest number of cycles is shown first.  
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4.4 Data Selection 

 
Via the Data Selection dialog you can finetune the data selection even more. This dialog will apear 
after you click at the Data selection button at the menu panel. 
Via this menu you can define a data selection filter on the recordings you have selected via the 
recording selection dialog as described in the previous chapter.  
Initially the Data Selection dialog looks like: 
 

 
 
Allmost all entry fields are disabled because the Select all checkbox is marked as selected, this means 
no filtering at all.  
If you will however filter the selected data you have to un-check this checkbox, now the dialog looks 
like: 
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The other checkboxes are now enabled and can be set selected or not.  
If you set the first checkbox to selected then the fields behind this checkbox will be enabled. 
 

 
 
Now you can select a log field to be used to define the filter. 
 

 
 
Next you can select the comparison operator: 
 

 
 
The last field to be entered is the value to be used by the comparision. In the selection below we will 
select all recordings from the recording selection where the DUT is equal to SW4: 
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If you now close this dialog by clicking at the OK button then the table shows only recordings from the 
already selected recordings where the DUT equals to SW4 
 

 
 
 
You can use more rules for the data selection for example: 
 

 
 
This will result in: 
 

 
 
 
If you select the Date_and_Time Log field in the Data Selection dialog then the button behind the 
Value entry will be enabled. 
 

 
 
If you press this button then the Date Time Entry dialog will be shown. This dialog is used to enter a 
date time. In the dialog below 1:00:00PM at 19th of January 2012 is selected.  
 

 
 
If the above filter is used then only the recordings done after 1:00:00PM at 19th of January 2012 will be 
selected. 
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4.5 Copy – Paste 

 
It is possible to copy and paste a log file reader sheet. This chapter will show you how this works. 
 

• Select the log file reader sheet which you want to copy 

• Select the main menu Edit -> Copy 
 

 
 

• Create a new log file reader sheet using the menu Sheets-New Log File Reader 
 

 
 

• A new empty Log File Reader sheet is created. 
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• Now select Paste in the Edit menu 
 

 
 

• The Log File Reader sheet has now been copied: 
 

 
 
After you have copied the sheet you can change the selected data via the Recording selection and/or 
the Data selection dialogs. The advantage of working like this is that you have the same table layout 
for multiple log file reader sheets. It is recommanded that you change the table name and the sheet 
name. 
 
Changing the sheet name: 

• Right mouse click at the titlebar of the table 
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• Change the Name and press OK 

 
Changing the sheet name: 
 

• Select Rename sheet ‘Log File Reader’ in the Log File Reader main menu  
 

 
 

• Enter the new name: 
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4.6 Reporting 

 
There are three different ways you can use for reporting. 
 

1. Using the toolbox buttons to post, append or copy to Excel. 

 
 

2. Using the toolbox button to post to Word 

   
 

3. Using the Perception report sheet. 
 
 
When you use the Perception report sheet you still have the ability to post the report to Word. The 
difference between posting the table directly to Word and posting the report to Word is that in the first 
method a Word table is created and filled with data, most of the time you have to manully adjust the 
Word table layout to get a nice view. However when posting the report to Word a picture is created the 
layout is exactly as you have defined in the report, no extra work needed in Word. 
 
There are different ways to use the Perception report sheet. You can create a report page per table or 
you create per table a report save the report using a descriptive name. A report layout can be saved to 
a file using the menu Report -> Save Report As.. 
 

 
 

4.6.1 Creating a report layout using the Report sheet 

 

• Go to the report sheet 

• Go to the Report Setup… 
 

 
 

• Select the Page size, in this example it is set to A4 
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• Page orientation, most likely landscape 

• Number of pages most likely 1, but if you have more tables you can select a page per table. 

• Close the report Setup window. 

• Add a table to the report. 
 

 
 

• Open the properties window of the new table 

• Select “Link to User table” and then select the usertable you want to use as the source for 
this report table. 

 

 
 

• Close the porperties window, allign the table and if the layout is OK lock it using the Object 
Attributes window at the left side. 

 

 
• The report is ready to be used. 
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4.6.2 Using userkeys for reporting 

 
Via a userkey you can post a Perception report to Word.  
This paragraph describes how to do this. 
 

• Create a new user keys window, Menu Window -> User Keys -> Add New User Keys Window 
 

 
 

• A new empty user keys window is created.  
 

 
 

• Add a new key to this new user keys window by clicking at the + key at the bottom of the 
window. 

• Select the Post Report to Word key action 
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• Configure the Post Report to Word action, a location and name for the Word report document 
has to be defined  

 

 
 

• Set the Key text for example to Post 

• Set the Key help text for example Post report to Word 

• Optional you can give the window a descriptive title for example Reporting 
 

 

 
 

• Close the setup window and your user key is ready to be used. 
 

 
 
 
The following example shows how to use three user keys for three different tables to be reported to 
Word using the Perception report sheet. 
 
The following setup is used: 
 

• Perception has been extended with three Log File Reader sheets 

• There are three different Perception report file layouts available (*.pReportLayout files), for 
each Log file reader sheet one. 
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• Three different user keys will be defined 
 

 
 

• Per key two actions are defined 
 

 
 

• First action is Load sheet configuration this action is used to load the correct report file 
layout. For example file LG1600.pReportLayout 

 

 
 

• The second action is Post Report to Word, this action has to be configured as well; The name 
of the report document has to be entered 
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• Repeat these steps for the other two user kesy, they should point to different report layouts. 
 

4.7 Saving / Loading log file reader sheet configuration 

 
In the Log File Reader main menu you can find two items: 
 

• Load log file reader sheet configuration 

• Save log file reader sheet configuration 
 
 

 
 
These menus are used to load or save the complete setup of the log file reader sheet, this means not 
only the layout of the sheet, but also: 
 

• the actual log file name  

• the selected recordings  

• the data selection settings 

• the content of the user sheet 
 
This saving and loading of the configuration works simular to the way the standard Perception sheets: 
Reporting, Formula, Settings and Information are working. This means the configuration can be saved 
in a separate file having the extension *.pLogTable. The configuration is also always automatically 
saved in the experiment file (*pNRF) and the workbench file (*.pVWB), therefore it can be re-loaded 
from these files as well. 
 

4.8 Tips 

 

• If the table redraw is very slow try again without using different fonts or font styles like e.g. 
Bold. 

• For large data sets always first do a recording selection before doing anything else. 

• Save your table layouts for later reuse. 
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